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(RealToon Shader) 
 
It’s an AAA Anime - Toon Shader/Cel Shading Shader for Unity3D. 
The goal/aim of this shader is to achieve real Anime/Toon look in RealTime 3D. 
 
You can also achieve any style/stylized you want, more than Anime/Toon look. 
 
All Real time lights can be use, from real time Directional Light, Spot, Point to 
real time Area Light. 
 
It is possible to use RealToon in HDRP’s DXR/Ray tracing mode. 
Realistic + NPR/Non-Photorealistic are possible with the combination use of 
Unity’s Shaders + RealToon Shaders. 
 
You can use RealToon and other shaders, together. 
 
Use RealToon Shader for games, animations/film, illustrations/art, VTuber, 
Virtual Chat Avatar Shader and any projects. 
 
RealToon shader can also be use on projects made, 
Mobile (Android/iOS) and Game Console (Xbox, PlayStation and Switch). 

 

 

 



 

3 RealToon (MJQ Studio Works © 2016 - 2026) 

 

3 User Guide 

[Table of Contents] 

4. Getting Started & Unpacking The Shaders 

5. How To Use 

6. RealToon Shaders 

7. RealToon Tools 

12. RealToon Tools Tips/Notes/How To Use 

14. RealToon Effects/Post-Processing 

17. How to Use RealToon Post-Processing 

19. RealToon Shader Options and Features 

44. Important Notes/Tips 

46. Contact/Support/Social Network 

 

 

 

 

 

 



 

4 RealToon (MJQ Studio Works © 2016 - 2026) 

 

4 User Guide 

[Getting Started] 
-  Before you start, you’ll need to unpack the shader package that corresponds to your project render 
pipeline, before that there are some things you need to know about Unity’s Render Pipeline. 
If you already know it, just skip to the Unpacking the Shaders section. 
 
- Firstly there are 2 types of Unity Render Pipeline, Unity Built-In/3D Render Pipeline and Unity 
SRP/Scriptable Render Pipeline (URP - HDRP). 
Under SRP there are 2 Unity made SRP, URP/Universal Render Pipeline and HDRP/High Definition 
Render Pipeline. 
 
 
 
 
 
 
 
 
 
 
- Now you know what those unity render pipelines are, so we can start unpacking the shader you need. 
All the shader packages are in the folder RealToon Shader Packages. 
 

 
 
 
 
 
 
 
 
 
 

*Unity Built-In/3D Render Pipeline is the old unity render pipeline. 
 
*Unity SRP/Scriptable Render Pipeline (URP - HDRP), is the new and modern render pipeline. 

*URP/Universal Render Pipeline – Formerly named LWRP and It is universal and focuses on 
low and high quality visuals that can be deploy to all devices. 
*HDRP/High Definition Render Pipeline – Focuses on advance high quality visuals and can 

be deploy to modern devices that supports compute and modern advance features and visuals. 
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[Unpacking the Shaders] 
 
*Recommended Unity versions for Built-In RP/3D: 

From Unity 5 to current latest unity version. 
 

*Recommended Unity and SRP Versions: 
[RealToon LWRP] - Unity 2018 and LWRP V4.0.0 or latest version. 
[RealToon URP] - Unity 2019.3.0 to newer versions and URP V7.1.1 or latest version. 
[RealToon HDRP] - Unity 2019 to newer versions and HDRP V7.2.0 or latest version. 
 

*Recommended Tuanjie (Unity China Version) for Built-In RP, URP and HDRP : 
Tuanjie 1.6.0 to the latest version. 

 
*If your project is 3D or Built-In RP: 

1. Go to folder RealToon Shader Packages -> Built-In RP [3D]. 
2. Double click RealToon Built-In RP [3D] package to unpack. 
If you are using the latest unity version, double click - unpack the latest one with the 'Later' 
word on it. 
3. Click Import. 

 
*If your project is Universal Render Pipeline or High Definition RP: 

1. Go to folder RealToon Shader Packages -> SRP (LWRP - URP - HDRP). 
2. Open the folder that correspond to your project render pipeline. 
3. Double click - unpack the version you need or the latest one with the 'Later' word on it. 
4. Click Import.  

*You can also import the packages on the Welcome Screen: 
1a. Go to Window > RealToon > Welcome Screen. 
1b. The already opened Welcome Screen. 
2. Under the Packages section, click the button RealToon URP/HDRP/Built-In [3D]. 
3. Click All then click Import. 
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[How to use] 
 

A. How to use RealToon Shader: 

a. Create a material by pressing mouse button Right on the Project 
window/panel. 

b. Go to Create -> Material. 
c. Name your material then press keyboard key Enter. 
d. Click your created material. 
e. Go to Inspector window/panel then change the Shader by left 

mouse button - click the drop down menu. 
 
* For 3D/Built-In RP: Go to RealToon -> Default and select Default. 
* For Universal Render Pipeline: Go to Universal Render Pipeline -> 
Default and select Default. 
* For High Definition RP: Go to HDRP -> Default and select Default. 
 

f. Drag your created material to the object you want to apply. 
 

B. How to use RealToon Effects (Built-In RP/3D): 

a. Select a camera. 

b. Add component -> RealToon -> Effects. 

c. Select the effect/s you want to use. 

 

C. How to use RealToon Tools: 

a. Select an object or an empty game object 

b. Add component -> RealToon -> Tools. 

c. Select a tool you want to use. 
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[RealToon Shaders] 
 

(RealToon Shaders for Built-In RP/3D) (RealToon Shaders for SRP) 

A. Default 
a. Default 

* The default RealToon shader. 
 

b. Fade Transparency 
* A transparent shader. 
* It also has the functions and feature of  
   the Default shader. 
* It can’t receive shadow  
   but can cast shadow. 
 

c. Refraction 
* A Refraction shader. 
* It can’t receive shadow  
  and can cast shadow. 

 
B. Default - Tessellation 

a. Default 
* The default RealToon shader. 
* With tessellation. 
 

b. Fade Transparency 
* A transparent shader. 
* It also has the functions and feature of  
   the Default shader. 
* It can’t receive shadow  
   but can cast shadow. 
* With tessellation. 
 

c. Refraction 
* A Refraction shader. 
* It can’t receive shadow  
  and can cast shadow. 
* With tessellation. 

 
C. Lite 

a. Default 
* Lite version of the Default shader. 
 

b. Fade Transparency 
* Lite version of the Fade Transparency 
shader. 

 
 
 
 

A. LWRP 
a. Default 

* The default RealToon shader. 
 

b. Fade Transparency  
* A transparent shader. 
* It also has the function and 
features of the Default Shader. 
* It can’t receive shadow but can 
cast shadow. 
 

B. URP 
a. Default 

* The default RealToon Shader. 
* It has the transparent feature. 
* The transparent feature can 
   receive and cast shadow. 
* With lightmap. 
* With 2 available on shader 
   outline to be use,  
   Traditional Outline and  
   Screen Space Outline. 
 

C. HDRP 
a. Default 

* The default RealToon Shader. 
* It has the transparent feature. 
* The transparent feature can 
   receive and cast shadow. 
* With DXR/Ray Tracing. 
* With 2 available on shader 
   outline to be use,  
   Traditional Outline and  
   Screen Space Outline. 
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[RealToon Tools] 
 

*Custom Shadow Resolution Tool 

-  This tool is use for customizing the light source shadow resolution. 
    Can only be use on Built-In RP/3D. 
 

Settings 

Value (Default: 2048)  

 
-  It’s the resolution value of the shadow map 
 

Final Resolution (Default: No Default Value) 

 
- This is the shadow map final resolution. 
  This is basically x2 value of the value you entered. 
 

Reset (Default: Unchecked) 

 
-  To reset he settings - value 
 
 

*Frame By Frame Rendering Tool 

-  Frame by Frame Rendering is a simple tool to render each frame to PNG File. 
    (Use For Animation & Illustration/Art) 
 
-  Two types of Frame By Frame Rendering Tool script: 

1. Frame by Frame Rendering (Default) – Auto Render when press play. 

2. Frame By Frame Rendering (Manual) – Manual Render, frame by frame. 

Settings 

Path Folder (Default: Rendered Files)  

 
 - A path/location to where to save the PNG Files. 
 
[Note] 
*If you put the name folder only, it will be created to your Unity3D root project folder. 
*If you want to save the files to a different location/drive, include the drive letter, Example C:\PNGFiles. 
*If this field is empty, it will create the folder Rendered Files. 
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PNG File Name (Default: Frame) 

 
-  The file name 
 
[Note] 
*If this field is empty, it will name the file Frame. 
 

Frame Rate (Default: 24) 

 
- The frame rate of the frame by frame session. 
 

Start Frame (Default: 0) 

 
- The beginning of the frame. 
 

End Frame (Default: 0) 

 
- The end of the frame. 
 

Single Frame Rendering Mode (Default: Unchecked) 

 
- Render a single image only. 
 
[Note] 
*This will ignore Frame Rate, Start Frame & End Frame. 
*It will only render Frame 1. 
*If Checked/Enabled file name will be named “YouFileName Hour_Min_Sec”. 
*If Uncheck/Disable file name will be named “YouFileName FrameNumber”. 
 

Picture Mode (Default: Unchecked) 

 
- Render a single image only. 
 
[Note] 
*This option is only available on the Frame by Frame (Manual) version. 
*This is similar to Single Frame Rendering Mode. 
 

 

Information - This section will only display information about the rendering and operations. 

Last Rendered Frame (Default: No Default Value)  

 
-  Display the last rendered fame. 
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Info (Default: Empty) 

 
- This is the shadow map final resolution. 

 

*Smooth Object Normal – Helper 

- A helper script for the RealToon Feature Smooth Object Normal. 
- This script will help the Smooth Object Normal to follow the object’s animation. 
 

Settings 

Intensity (Default: 0)  

 
-  0 means object’s default normals while 1 is the full smoothed normals. 

Material (Default: Empty) 

 
-  A material that uses RealToon – Smooth Object Normal feature. 
 

Object Helper (Default: Empty) 

 
- An object to help adjust the smoothed/ignored object normals. 
 

Show Normal (Default: Unchecked) 

 
- This will the display the object’s/smoothed normals. 
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*ShadowT SDF Mode – Helper 

- A helper script for the RealToon ShadowT - SDF Mode. 
- This script will help you to control ShadowT SDF feature in one script. 
 

Settings 

Material (Default: Empty) 

 
-  A material that uses RealToon Shader. 
 

Object Helper (Default: Empty) 

 
-  A material that uses RealToon – Smooth Object Normal feature. 
 

SDF Texture (Default: Empty) 

 
-  A texture/map to be sure as SDF Shadow. 
 

Light Threshold (Default: 200) 

 
-  The amount of light. 
 

Hardness (Default: 1) 

 
-  How Hard or Soft the SDF Shadow. 
 

Forward Inverted (Default: Unchecked) 

 
- Invert the Forward/Front position of the object. 
 

Right Inverted (Default: Unchecked) 

 
- Invert the Right position of the object. 
 

Self Shadow (Default: Unchecked) 

 
- Enable/Disable RealToon Self Shadow feature. 
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*Perspective Adjustment - Controller 

- A controller script for the RealToon Prespective Adjustment. 
- This script will help you to control Prespective Adjustment feature in one script. 
 

Settings 

Perspective (Default: 1) 

 
-  This will change the perspective of an object to 2D or 3D or FOV stretch look. 
 

Clip (Default: 0) 

 
-  This will change the clipping on the object. 
 

Close Up Size (Default: 0) 

 
- This will adjust the size of the object when the camera is closer.  
 

Close Up Size Smooth Transition (Default: 1) 

 
-  How smooth the transition of the sizing. 
 

Close Up Size Distance (Default: 0) 

 
-  Distance transition from the camera to the object. 
 

Object Position Z (Default: 0) 

 
-  Z position of the object in Clip Space. 
 

Can Animate It (Default: Unchecked) 

 
- Can animate the values/properties or create keyframe. 
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*Swap Shader To RealToon - Tool 

- A tool to swap from VRoid|VRM shader or Unity shaders to RealToon shader. 
- It supports all Unity Rendering Pipeline shaders Built-In/BiRP, URP and HDRP.  
 

Settings 

From Shader  

 
- From what shader is the selected material/s. 
 

VRoid|VRM Options 

 
*Force Unlit:  
  This will make the material to unlit look, no lighting and shadow. 
  It will enable RealToon’s Hide Directional Light Shadow, Hide Point, Spot and Area Light 
  Shadows/Hide Point and Spot Light Shadows options, enable Selflit feature and adjust the selflit 
  Power option, disable Receive Environmental Lighting and GI option, disable Enable Punctual Lights/ 
  Enable Additional Lights option, enable use Traditional Light Blend option, disable Normal Map 
  feature and Self Shadow feature. 
 
*Force Transparent Material To Cutout: 
  This will force all transparent material to cutout. 
  It will enable RealToon’s Transparent Mode then Cutout feature and set the Cutout to 4.0. 
 
* Enhance Light Highlight Color Intensity: 
  This will enhance the light highlight color on the material/object. 
  It will adjust the RealToon’s Highlight Color Power option. 
  On Built-In/BiRP, this is not available if the Project Color Space is Gamma. 
 
*Include Shade/Shadow Color: 
  This will include the selected VRoid|VRM Shade/Shadow color. 
  It will copy the selected VRoid|VRM Shade/Shadow color to RealToon’s Overall Shadow Color 
  options. 
  On URP, It will also adjust the Overall Shadow Color Power. 
 
*Light Affect Shadows: 
  This will let the light intensity and color affect shadows. 
  If not enabled, The light will not affect the shadow and it will prevent overexpose shadow color when 
  there are more lights on the scene and high intensity light value. 
  This will enable RealToon’s Light Affect Shadow option. 
 
*Disable Received Shadows: 
  This will disable received shadows from other objects including received self cast shadows. 
  It will disable RealToon’s Hide Directional Light Shadow, Hide Point, Spot and Area Light 
  Shadows/Hide Point and Spot Light Shadows options. 
 



 

14 RealToon (MJQ Studio Works © 2016 - 2026) 

 

14 User Guide 

*Include Emission: 
  This will include VRoid|VRM Emission. 
  It will copy the Emission Color and Emission Map(if present) to RealToon Selflit Color and Mask. 
  Take note: some VRoid|VRM default configuration will use Emission to light the character or to 
  make it unlit, leave the Include Emission option disabled if you didn’t configure the Emission. 
 
*Use Emission Map and Color as Gloss Texture: 
  This will use the Emission Map (if present) and Emission Color as Gloss. 
  It will enable the RealToon’s Gloss Texture feature then use the Emission Map to it and copy the 
  Emission Color to RealToon’s Gloss Color options. 
 
*Force Enable Rim Light And Use White Color: 
  This will force to use Rim Light and use White color to it. 
  It will enable RealToon’s Rim Light feature then set the Rim Light Color option to White. 
 
*Enable Global Illumination Shade: 
  This will enable the GI soft shade look. 
  It will adjust the RealToon’s GI Shade Threshold option to 1. 
 
*Global Illumination Flat Shade: 
  This will make the GI shade to look flat or cel shade. 
  It will enable RealToon’s GI Flat Shade option. 
 

Unity Options 

 
*Light Affect Shadows: 
  This will let the light intensity and color affect shadows. 
  If not enabled, The light will not affect the shadow and it will prevent overexpose shadow color when 
  there are more lights on the scene and high intensity light value. 
  This will enable RealToon’s Light Affect Shadow option. 
 

 

 

Compatible Shaders 

VRoid VRM Unity Built-In Unity URP Unity HDRP 

 
 
 

               VRM 
VRM10 

VRM10 (URP) 

 
Standard 

Standard (Specular setup) 
Unlit/Color 

Unlit/Texture 
Unlit/Transparent 

Unlit/Transparent Cutout 

 
 

Complex Lit 
Lit 

Simple Lit 
Unlit 

Baked Lit 

 
 
 

Lit 
Lit Tessellation 

Unlit 
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*RealToon Shader Cache - Tool 

- A tool to reduce or clear cached RealToon Shader. 
- Useful for after Update RealToon Shader or Re-import RealToon Shader.  
 

Settings 

Reduce/Clean Cached RealToon Shader  

 
-  This will reduce/clean/clear cached RealToon Shader. 
 

Re-import RealToon Shader 

 
-  Re-import RealToon Shader folder and contents. 
-  This will cache RealToon Shaders again. 
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[RealToon Tools Tips/Notes/How to Use] 
 

(Frame By Frame Rendering) 

[For Frame By Frame Rendering Both (Default & Manual)] 

1. You can pause rendering by click pause button. 

2. Stop render immediately by click play button again. 

3. You cannot start render if the folder has files on it so you need to change the Path Folder to another 

location or folder. (Applies only to Non Picture Mode & Single Frame Mode) 

4. You can start render even if the folder has files on it. (Applies only to Picture Mode & Single Frame 

Mode) 

5. You can create folder by just putting a folder name that is not yet exist in the current location/path. 

(Applies to Path Folder) 

6. To set the resolution just set it in the Game view or Game panel. 

 

*For Frame By Frame Rendering (Manual)* 

1. Click Render to start render, once clicked it will turn back to unchecked means render 1 frame not 

continuous unlike Frame By Frame Rendering (Default). 

2. You can overwrite a specific saved frame by setting the Frame Number to the frame number you 

want to overwrite then click Render. Be sure that frame number is in the folder. Be careful not to double 

the Render or else it will overwrite the next frame number that is already saved. 

 

*For Frame By Frame Rendering (Default)* 

1. Click play button to start render, once the button is clicked Current Frame will start moving or display 

the current frame once the Current Frame reached the Start Frame number it will start rendering then 

later if Current Frame reached the Start Frame number it will stop render. To completely end rendering 

click play button. 

2. If you render a scene with timeline, set Frame Rate to the frame rate of timeline. Example “Timeline 

frame rate is 60 = Frame By Frame Rendering (Default) Frame rate is also 60”. If the two is not equal the 

output is not synchronized especially if you edit it in your Video Editor Software or Compositor Software. 
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(For Importing PNG files to your Video Editor or Compositing Software) 

1. Import PNG files as PNG Sequence or Image Sequence, be sure your video editor or compositing 

software has this features or option. Be sure PNG files are numbered frames like “Frame 0002 to Frame 

9000 or higher”. 

2. Change the imported PNG Sequence or Image Sequence file frame rate to the frame rate you set in 

your Frame by Frame Rendering Settings. 

 

(Swap Shader To RealToon  – Tool) 

[How to use] 

1. Click Window then go to RealToon -> Swap Shader To RealToon. 
2. Select the Materials on your project window/panel. 
3. Select from what Shader. 
4. Select the options you need if available. 
5. Click Click To Swap To RealToon Shader. 
6. All materials shader are now swap to RealToon Shader. 
 

*Note: Not all Unity Shader properties and settings will be copied. 

 

(Smooth Object Normal – Helper) 

[How to use] 

1. Select an Object/Model. 
2. Click Add Component and go to RealToon -> Tools and select Smooth Object Normal – Helper. 
3. Select again the Object/Model and go to Smooth Object Normal - Helper. 
4. Assign a material that uses RealToon Shader to the Material slot, this will automatically enable 
     Smooth Object Normal feature. 
5. Change the Intensity to full right. 
6. Enable Show Normal, to display the Normals. 
7. Put an Object or Bone to the Object To Follow slot, This will be followed by the Smooth Object          
    Normal feature to maintain the shade position. 
6. Disable Show Normal, to hide the displayed Normals. 
 
*Note: For option tooltip or description, just hover your mouse to the options. 
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(ShadowT SDF Mode – Helper) 

[How to use] 

1. Select an Object/Model. 
2. Click Add Component and go to RealToon -> Tools and select ShadowT SDF Mode – Helper. 
3. Go to the Inspector then ShadowT SDF Mode – Helper. 
4. Assign a material that uses RealToon Shader to the Material slot, this will automatically enable 
    ShadowT feature and SDF mode option. 
6. Put an Object or Bone to the Object To Follow slot, This will be followed by the ShadowT - SDF Mode 
to maintain the shade position similar to Smooth Object Normal feature. 
7. Click the material you put onto the Material slot then go to Shadow category then ShadowT then put  
    the SDF Texture onto the ShadowT texture slot. 
8. Adjust the Light Threshold to increase the light area of the shade, this is mostly useful when using 
    Point, Spot and Area lights. 
 
*Note: For option tooltip or description, just hover your mouse to the options. 

 

(Perspective Adjustment - Controller) 

[How to use] 

1. Click your Object/GameObject  
2. Go Inspector Panel/Windows then click Add Component 
3. Click RealToon -> Tool -> Perspective Adjustment Controller. 
 

*Note: Once the component added into your selected object, it will enable the “Perspective 

Adjustment” feature in your object materials that uses “RealToon Shader”. 

For option tooltip or description, just hover your mouse to the options. 
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(Smear Effect – Helper) 

[How to use] 

1. Click your Object/GameObject  
2. Go Inspector Panel/Windows then click Add Component 
3. Click RealToon -> Tool -> Smear Effect - Helper. 
 

*Note: Once the component added into your selected object, it will enable the “Smear Effect” feature 

in your object materials that uses “RealToon Shader”. 

For option tooltip or description, just hover your mouse to the options. 
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 [RealToon Effects/Post-Processing] 
 

*Sobel Outline Effect 

-  Full screen sobel type outline and can only be use on Built-In RP/3D. 
 
Settings 

Outline Width (Default: 0)  

 
- Outline width or line thickness. 
 

Outline Color (Default: White) 

 
- Outline Color. 
 
[Note] 
*Change this to white if you want the screen color to color the outline. 
*Increase the Color Power to make it dark. 
 

Color Power (Default: 2) 

 
-  How strong the outline color is. 
 
[Note] 
*Negative values will make it light, while positive values will make it strong/dark color. 
 

 

*DeNorSob Outline (Post-Processing) 

- Depth, Normal and Sobel Based Outline into one Post-Processing. 
- Can only be use on URP and HDRP. 
 
Settings 

Outline Width (Default: 0)  

 
-  Outline width or line thickness. 
 

Depth Threshold (Default: 900) 

 
- This will adjust the Depth near and far. 
 



 

21 RealToon (MJQ Studio Works © 2016 - 2026) 

 

21 User Guide 

[Note] 
*Positive values will move the Depth far but will reduce inner outlines if too far. 
*Negative values will move the Depth closer but will create some unwanted outline looks if too close. 
*Be sure to balance it. 
*Increase this more than 900 to have a clean silhouette style outline. 
 

Normal Threshold (Default: 1.3) 

 
- This will adjust the Normals. 
 
[Note] 
*Positive values will show more outer and inner outline. 
*Negative values will reduce more outer and inner outline. 
 

Normal Min (Default: 1) 
Normal Max (Default: 1) 

 
- This will adjust the Minimum and Maximum of the Normal. 
 
[Note] 
*If Min and Max are in the same value, it will make the outline look hard or hard edge. 
*Adjusting these will help you to get more outlines. 
 

Sobel Outline (Default: Unchecked) 

 
- Turn on Sobel Outline. 
 
[Note] 
*If this turned on, Depth and Normal based outline will be disabled. 
*If you want to use both Depth – Normal Base Outline and Sobel Outline, 
  Turn on Mix Depth Normal And Sobel Outline option. 
 

Sobel Threshold (Default: 0) 

 
- The amount of outline to be shown. 
 

White Threshold (Default: 0) 

 
- The amount of outline that has been detected in the white or highlight area of the screen. 
 

Black Threshold (Default: 0) 

 
 
- The amount of outline that has been detected in the black or dark area of the screen. 
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Outline Color (Default: Black) 

 
- Outline Color. 

Mix Full Screen Color (Default: Unchecked) 

 
- This will mix the Screen Color into the Outline Color. 
 

Layers To Exclude (Default: Nothing) 
 
- Exclude the layers you don’t want to be affected by DeNorSob Outline. 
 

Show Outline Only (Default: Unchecked) 

 
- Show outline only. 
 

Mix Depth Normal And Sobel Outline (Default: Unchecked) 

 
- This will mix Depth – Normal Based Outline and Sobel Outline. 
 

 
[Note About DeNorSob Outline] 
- The outline width will be affected by the screen resolution, the higher the resolution the 
   thinner the outline width, the lower the resolution the thicker the outline width. 
 
- If some of your objects are Transparent, the outlines from the other object will be visible on the 
object, see through effect. 
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[How To Use RealToon Post-Processing] 
 

*Sobel Outline (Built-In RP/3D) 

Built-In RP/3D 

 
1. Select a camera on the scene. 
2. Click Add Component and go to RealToon -> Effect. 
3. Select Sobel Outline. 
 

 
 

*DeNorSob Outline (URP and HDRP) 

URP/Universal Render Pipeline 

 
1. Open the folder Settings and select the default ForwardRenderer/Renderer or your own created renderer 
     on the project window/panel. 
 
[For URP 16 and below] 
a. Click Add Render Feature and select Depth-Normals Feature.  
b. Click Add Render Feature again and select De Nor Sob Outline.  
 
[For URP 17 and later] 
a. Click Add Render Feature and select DeNorSob Outline Renderer Feature.  
b. Create a volume  by right click the Hierarchy then go to Volume then click Global Volume. 
c. Select the Global Volume you’ve created in the Hierarchy then click New in the Inspector panel. 
d. Click Add Override then go to Post-Processing then RealToon then click DeNorSob Outline. 
 
[Note] 
- Before you start using it, you’ll need to turn on Depth Texture on the camera or on URP settings. 
  This is needed for the Depth Based Outline. 
- Depth-Normals Feature is needed for the Normal Based Outline. (For URP 13 and below) 

 
 
* If you are planning to use the effect in making games or make a build 
 
1. Go to Edit -> Project Settings then Graphics. 
2. After that add 1 to the Size under Always Included Shaders, now it adds another element. 
3. Click the last element then search for DeNorSob Outline then click it. 
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HDRP/High Definition Render Pipeline 

 
1. Go to GameObject -> Volume then click Global Volume. 
2. Then next click Global Volume in the Hierarchy window/panel or in the scene. 
3. Click New, this will create a Global Volume Profile. 
4. Click Add Override then go to Post-Processing -> RealToon then select DeNorSob Outline. 
 
* Then next we will add that effect in the Custom Post Process Order so that the effect will work. 
 
5. To add Go to Edit -> Project Settings -> HDRP Default Settings then scroll down to Custom Post Process Order. 
 
    (For HDRP 7 and 8: Click the + sign under the After Post Process then click RealToon. Effects.DeNorSobOutline.) 
    (For HDRP 10 to later: Click the + sign under the Before TAA then click RealToon. Effects.DeNorSobOutline.) 

 
 
 
* If you are planning to use the effect in making games or make a build 
 
1. Go to Edit -> Project Settings then Graphics. 
2. After that add 1 to the Size under Always Included Shaders, now it adds another element. 
3. Click the last element then search for DeNorSob Outline then click it. 
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[RealToon Shader Options and Features] 
 
 

Texture - Color Shader Type Render Pipeline 
Double Sided (Default: Off)  

 
All RealToon Shader 

 

Built-In RP/3D 
LWRP 

 
- Make the other side of a plane object or face visible. 
 

Culling (Default: Back) 
 
- Controls which sides of polygons should be culled (not drawn). 
 
[Note] 
* Back: Don’t render polygons that are facing away from the viewer. 
* Front: Don’t render polygons that are facing towards the viewer,  
  Used for turning objects inside-out. 
* Off: Disables culling - all faces are drawn,  
       This also called Double Sided." 
 

Default Shader URP and HDRP 

Texture/Main Texture (Default: Empty) 

All RealToon Shader All Render Pipeline  
- The main texture of the object. 
 

Texture Pattern Style (Default: Unchecked) 

All RealToon Shader All Render Pipeline 
 
- Turn Texture/Main Texture into pattern style. 
 

Refraction Intensity (Default: 1) 
 

Refraction Shader 
 

Built-In RP/3D 
 

- How strong the Refraction is. 
 

Texture Intensity (Default: 0) 
 

Refraction Shader 
 

Built-In RP/3D 
 
- How visible the Texture/Main Texture is. 
 

Main Color (Default: White) 

All RealToon Shader All Render Pipeline 
 
- The main color of the object. 

Main Color Power (URP Default: 0.8) | (HDRP Default: 0.15) 

Default Shader URP and HDRP 

 
 
 
- How strong the Main Color color. 
 
[Note] 
*This option will also prevent overexposure when using white or bright colors. 
*Set this to 1 if you want the true brightness of the Main Color. 
*The default value for RealToon URP is 0.8 while the RealToon HDRP is 0.15 
*Each time you change shader from RealToon URP to RealToon HDRP or 
opposite, it will automatically adjust to the right value. 
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Mix Vertex Color (Default: Unchecked) 

All RealToon Shader All Render Pipeline 

 
- Mix the object vertex color to the Main Color. 
 
[Note] 
*This can also be use as View Object Vertex Color for debug.  
 

Main Color in Ambient Light Only (Default: Unchecked) 

All RealToon Shader All Render Pipeline 

 
- Put the Main Color into the Ambient light. 
 
[Note] 
*This will only works if there is Ambient/Environmental Light/GI. 
*Enable this if you’re doing multi-shading. 
 

Highlight Color (Default: White) 

All RealToon Shader All Render Pipeline 

 
- Put the Main Color into the Ambient light. 
 
[Note] 
*This will only works if there is Ambient/Environmental Light/GI. 
*Enable this if you’re doing multi-shading. 
 

Highlight Color (Default: 1) 

All RealToon Shader All Render Pipeline 
 
- Highlight color power or intensity. 
 

Enable Texture Transparent (Default: Unchecked) 

Default Shader 
Built-In RP/3D 

LWRP 

 
- Enable texture transparent. 
 
[Note] 
*This is disabled if no texture assign on the Texture/Main Texture. 
 

 
MatCap/Material Capture Shader Type Render Pipeline 

Intensity (Default: 1)  
 
All RealToon Shader 

 
All Render Pipeline 

 
- How visible or strong the MatCap is. 
 

MatCap (Default: Empty) 

All RealToon Shader All Render Pipeline  
- A MatCap texture to be use. 
 

Specular Mode (Default: Unchecked) 

All RealToon Shader All Render Pipeline 
 
- Turn MatCap into specular style. 
 

Specular Mode (Default: Unchecked) 

All RealToon Shader All Render Pipeline 
 
- Turn MatCap into specular style. 
 

Specular Power (Default: 1) 

All RealToon Shader All Render Pipeline 
 
- How strong or intense the specular look is. 
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Mask MatCap (Default: Empty) 

All RealToon Shader All Render Pipeline 

 
- Mask the MatCap. 
 
[Note] 
*Use a Black and White or Grayscale texture/map. 
*White is the MatCap while the Black is the non MatCap part. 
 

 

Cutout Shader Type Render Pipeline 
Cutout (Default: 0)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- Cutout value or threshold 
 

Alpha Based Cutout (Default: Unchecked)  

All RealToon Shader All Render Pipeline 

 
- Use the Main Texture alpha for cutting out. 
 
[Note] 
*If this is unchecked it will follow the bright and dark colors of the Main Texture 
for cutting out. 
 

Soft Cutout (Default: Unchecked) 

Default Shader URP and HDRP 

 
- For a soft edge cutout. 
 
[Note] 
*This feature uses the dithering style cutout. 
* Currently to reduce the artifacts use a high resolution texture or use a high 
resolution screen size. 
You can also use some kind of full screen Anti-Aliasing. 
 

Anti – Aliasing Affect Cutout (Default: Unchecked) 

Default Shader URP 

 
- Anti-Aliasing/MSAA affects cutout. 
 
[Note] 
*This is Alpha To Coverage and it will only work if Forward/Forward+ Path 
Rendering is use. 
* If you turn off Cutout feature, this will revert to disable/off. 
 

Anti – Aliasing Affect Cutout (Default: 0.0001)   

 
- This will adjust the Anti - Aliasing Softness/Hardness Cutout. 
 

Default Shader URP 

Use Secondary Cutout Only (Default: Unchecked)  

All RealToon Shader All Render Pipeline 
 
- Use only the secondary cutout for cutting out. 
 

Secondary Cutout (Default: 0)  

All RealToon Shader All Render Pipeline 

 
- A texture to be use as secondary cutout. 
 
[Note] 
*You can use Colored or Black and White or Grayscale color texture. 
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Enable Glow (Default: Unchecked) 

Default Shader URP and HDRP 
 
- This will add a glow edge. 
 

Glow Color (Default: White) 

Default Shader URP and HDRP 
 
- The color of the glow. 
 

Glow Width (Default: 1) 

Default Shader URP and HDRP  
- How thick or thin the glow edge. 
 

 

Transparency Shader Type Render Pipeline 
Simple Transparency (Default:Unchecked) 

Default Shader URP and HDRP 

 
- Common simple transparency. 
 
[Note] 
*Only Opacity, Blend Modes and Affects Shadow (URP) are available. 
*Transparent Threshold and Mask Transparency are not available. 
  

Opacity (Default: 1) 

All RealToon Shader All Render Pipeline 
 
- How opaque the object is. 
 

Transparent Threshold (Default: 0)  

All RealToon Shader All Render Pipeline 
 
- The transparent alpha threshold of the object Texture/Main Texture. 
 

Blend – Source (Default: ScrAlpha) 

Default Shader URP and HDRP 
 

- Transparent blend source. 
 

Blend – Destination (Default: OneMinus ScrAlpha) 

Default Shader URP and HDRP 
 
- Transparent blend destination. 
 

Affect Shadow (Default: Checked) 

Default Shader URP 
 
- Transparent opacity affects shadow. 
 

Mask Transparency (Default: Empty) 

All RealToon Shader All Render Pipeline 

 
- Mask transparent. 
 
[Note] 
*Use a Black and White or Grayscale texture/map. 
*White is the non transparent part while the Black is the Transparent part or 
  just normal part. 
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Normal Map Shader Type Render Pipeline 
Normal Map (Default: Empty)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- The Normal Map to be use. 
 

Normal Map Intensity (Default: 1)  

All RealToon Shader All Render Pipeline 
 
- How strong the Normal Map is. 
 

 

Color Adjustment Shader Type Render Pipeline 
Saturation (Default: 1)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- Adjust the color saturation of the object. 
 
[Note] 
*- The outline width will be affected by the screen resolution, the higher the 
resolution the thinner the outline width, the lower the resolution the thicker the 
outline width. 
 

 

Outline Shader Type Render Pipeline 
Width (Default: 0.5)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- Outline width or thickness. 
 
[Note] 
*On Screen Space Outline mode, the Outline Width will be affected by the 
  screen resolution, the higher the resolution the thinner the Outline Width, the 
  lower the resolution the thicker the Outline Width. 
 

Width Control (Default: Empty)  

All RealToon Shader All Render Pipeline 

 
 
- A black and white or grayscale color texture to be use control the outline 
   width. 
 
[Note] 
*This will not work if the Width option is 0. 
*Black is 0 while White is 1. 
 

Enhance Outline Using Normal Map (Default: Unchecked) 

Default Shader HDRP 
 
- Use a normal map to enhance the outline normal direction. 
 

Normal Map (Default: Unchecked) 

Default Shader HDRP 
 
- A normal map for enhancing the outline normal direction. 
 

Normal Map Intensity (Default: 1) 

Default Shader HDRP 
 
- How strong the Normal Map is. 
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Outline Extrude Method (Default: Normal)  

All RealToon Shader All Render Pipeline 

 
- Outline extrusion type/method to be use. 
 
[Note] 
*Origin – The extrusion will be based on the object’s center of origin. 
*Normal – The extrusion will be based on the object’s normal direction. 
 

Outline Resize (Default: X:1 Y:1 Z:1) 

All RealToon Shader All Render Pipeline 
 
- Resizing the outline XYZ. 
 

Outline Offset (Default: X:0 Y:0 Z:0)  

All RealToon Shader All Render Pipeline 
 
- XYZ offset value of the outline. 
 

Double Sided Outline (Default: Off)  

All RealToon Shader All Render Pipeline 

 
- This will show the front side of the outline or change the culling of the outline 
   to off. 
 
[Note] 
*Useful for plane object. 
*Outline Z Position In Camera option is needed to be adjust to show the object. 
 

Color (Default: Black)  

All RealToon Shader All Render Pipeline 
 
- The color of the outline 
 

Mix Main Texture To Outline (Default: Unchecked)  

All RealToon Shader All Render Pipeline 
 
- This will mix Texture/Main Texture to outline Color.  
 

Noisy Outline Intensity (Default: 0)  

All RealToon Shader All Render Pipeline 
 
- How noisy is the outline is. 
 

Dynamic Noisy Outline (Default: Unchecked)  

All RealToon Shader All Render Pipeline 

 
- Moving noisy outline. 
 
[Note] 
*This will not work if the Noisy Outline Intensity is 0. 
 

Light Affect Outline Color (Default: Unchecked)  

All RealToon Shader All Render Pipeline 
 
- Light falloff, color and intensity affect outline color. 
 

Outline Width Affected By View Distance (Default: Unchecked)  

All RealToon Shader All Render Pipeline 

 
- Camera view distance affects outline width or thickness. 
 
[Note] 
*Far distance will increase outline width. 
*Near distance will decrease outline width. 
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Far Distance Max Width (Default: Unchecked)  

All RealToon Shader All Render Pipeline 
 
- The maximum width or thickness value when camera distance is far from the 
   object. 
 

Transparent Opacity Affect Outline (Default: Checked) 

Default Shader HDRP 

 
- Transparent affect outline opacity. 
 
[Note] 
*This only works if Transparent Mode is enabled. 
 

Vertex Color Blue Affect Outline Width (Default: Unchecked)  

All RealToon Shader All Render Pipeline 

 
- Object vertex color blue channel affect Outline Width. 
 
[Note] 
*This will not work if the Width option is 0. 
 

Use Screen Space Outline  / Use Traditional Outline 

Default Shader URP and HDRP 

 
- Use Screen Space Outline or use Traditional Outline. 
 
[Note] 
*This is NOT PER-MATERIAL. 
*THIS WILL MODIFY THE SHADER FILE and change the type of outline to be use. 
*On RealToon URP, only Depth Based Outline is available and Depth Texture is 
   needed to be On. 
*If Screen Space Outline is used and Transparent Mode is enabled, the outline 
  from the other object will be visible even if the transparent Opacity is 1 and 
  ZWrite is Off or On. 
 

Stencil : Pass (Default: Keep) 

Default Shader URP 

 
- Use for fixing/resolving Outline overlapping issues to other assets, objects and 
UI. 
 
[Note] 
*Use Keep for Mask UI while Invert for other assets like weather and fog. 
 

ZWrite (Default: On) 

Default Shader URP 

 
-  Turn on/off Z Depth on the outline. 
 
[Note] 
*This only affect Outline. 
 

ZTest (Default: LessEqual) 

Default Shader URP 

 
-  Determines whether a pixel should be rendered based on its distance from 
the camera compared to what is already drawn in the depth buffer (Z-buffer). 
 
[Note] 
*This only affect Outline. 
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Screen Space Outline Shader Type Render Pipeline 
Mix Outline To The Shader Output (Default: Unchecked)  

 
Default Shader 

 
HDRP 

 
- This will mix the outline looks and color to the shader output. 
 

Depth Threshold (Default: 900)  

Default Shader URP and HDRP 

 
- This will adjust the Depth near and far. 
 
[Note] 
*Positive values will move the Depth far but will reduce inner outlines if too far. 
*Negative values will move the Depth closer but will create some unwanted 
outline looks if too close. 
*Increase this more than 900 to have a clean silhouette style outline. 
 

Normal Threshold (Default: 1.3) 

Default Shader HDRP 

 

- This will adjust the Normals. 
 
[Note] 
*Positive values will show more outer and inner outline. 
*Negative values will reduce more outer and inner outline. 
 

Normal Min (Default: 1) | Normal Max (Default: 1) 

Default Shader HDRP 

 
- This will adjust the Minimum and Maximum of the Normal. 
 
[Note] 
*If Min and Max are in the same value, it will make the outline look hard or 
  hard edge. 
*Adjusting these will help you to get more outlines. 
 

 

Self Lit/Self Illumination Shader Type Render Pipeline 
Intensity (Default: 1)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- How strong or intense the Self Lit is. 
 

Color (Default: White)  

 All RealToon Shader All Render Pipeline 
 
- Self Lit color. 
 

Power (Default: 2) |(HDRP Default: 50) 

 All RealToon Shader All Render Pipeline 
 
- How strong the Self Lit color. 
 

Texture and Main Color Intensity (Default: 1) |(HDRP Default: 0) 

 All RealToon Shader All Render Pipeline 

 
 
- How strong the Texture/Main Texture and Main Color is for Self Lit. 
 
[Note] 
*Adjust this if the Main Texture and Main Color is too strong for Self Lit. 
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High Contrast (Default: Checked)  

 All RealToon Shader All Render Pipeline 

 
- Will turn the Self Lit into high contrast look. 
 
[Note] 
*This will mix Texture/Main Texture and Main Color twice for high contrast 
  look. 
*Uncheck this if you just want the color. 
 

Map Mode (Default: Unchecked) 

All RealToon Shader All Render Pipeline 

 
- Use Self Lit Mask as Self Lit Map/Emission Map. 
 
[Note] 
*This will allow you to use Emission Maps. 
*If this enabled, High Contrast will be disable and Self Lit Mask will be change 
to Self Lit Map. 
 

Mask Self Lit (Default: Empty)  

 All RealToon Shader All Render Pipeline 

 
- Mask Self Lit. 
 
[Note] 
*Use a Black and White or Grayscale texture/map. 
*White is the Self Lit while the Black is the non Self Lit or just normal part. 

 

Gloss Shader Type Render Pipeline 
Gloss Intensity (Default: 1)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- How visible or strong the gloss is. 
 

Glossiness (Default: 0.8) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- How gloss the object is. 
 

Softness (Default: 0) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- How soft the gloss is. 
 

Color (Default: White) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Gloss color. 
 

Color Power (Default: 10) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- How strong the gloss color is. 
 

Mask Gloss (Default: Empty) 

 
All RealToon Shader 

 
All Render Pipeline 

 
- Mask Gloss. 
 
[Note] 
*Use a Black and White or Grayscale texture/map. 
*White is the Gloss part while the Black is the non Gloss part or just normal. 
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Gloss Texture Shader Type Render Pipeline 
Gloss Texture (Default: Empty)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- A texture or image to be use as Gloss. 
 
[Note] 
*Use any Black and White or Grayscale color 4x4 or equal size texture/image. 
*If you’re using a wide size image, Adjust the X Tiling of the Gloss Texture`. 
 

Anisotropic Mode (Default: Unchecked) 

Default Shader URP and HDRP 

 
- Setting the Gloss Texture to Anisotropic Highlight Mode. 
 
[Note] 
*It will use Gloss Texture texture input as noise. 
 

Noise Texture Intensity (Default: 1) 

Default Shader URP and HDRP 
 
- How strong the Noise Texture distortion. 
 

Width (Default: 10) 

Default Shader URP and HDRP 
 
- Width of Anisotropic. 
 

Noise Texture Affect Width (Default: Unchecked) 

 
Default Shader 

 
URP and HDRP 

 
- Noise Texture affect Anisotropic Width. 
 
[Note] 
*White means 1 while Black is 0. 
 

Noise Texture Affect Width (Default: Unchecked) 
 

Default Shader 
 

URP and HDRP 
 
- Shift the Anisotropic to Up or Down. 
 

Softness (Default: 0)  

All RealToon Shader All Render Pipeline 
 
- How soft the Gloss Texture is. 
 

Pattern Style (Default: Unchecked) 

All RealToon Shader All Render Pipeline 
 
- Turn Gloss Texture into pattern style. 
 

Rotate (Default: 0) 

All RealToon Shader All Render Pipeline 

 
- Rotate Gloss Texture. 
 
[Note] 
*Adjust also the Gloss Texture Offset option to adjust the position if needed. 
 

Follow Object Rotation (Default: Unchecked) 

All RealToon Shader All Render Pipeline 
 
- Gloss Texture follows object rotation. 
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Shadow Shader Type Render Pipeline 
Overall Shadow Color (Default: Black)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- The overall shadow color of the object. 
 
[Note] 
*This will affect Realtime shadow, Self Shadow/Shade and ShadowT.  
*Change this to White if you want to use the Color Shadow Texture feature to 
   color the shadow. 
 

Overall Shadow Color Power (Default: 1)  
 

All RealToon Shader 
 

All Render Pipeline 
 
- How strong the Overall Shadow Color. 
 

Self Shadow & ShadowT At View Direction (Default: Unchecked)  

All RealToon Shader All Render Pipeline 
 
- Self Shadow and ShadowT follow the camera’s view or view direction. 
 

Reduce Shadow (Default: 0) 

Default Shader URP and HDRP 
 
- Reduce self cast shadow of the object. 
 

Reduce Shadow (Pointlight) (Default: 0)  

All RealToon Shader Built-In RP/3D 

 
- Reduce self cast shadow of the object. 
 
[Note] 
*This option will take effect when there’s a pointlight present on the scene. 
 

Point Light Shadow Visibility Distance (Default: 0)  

All RealToon Shader Built-In RP/3D 
 
- The amount of visible Point Light shadow on the object when the Point Light is 
move away from the object. 
 

Reduce Shadow (Spot & Directional Light) (Default: 10)  

All RealToon Shader Built-In RP/3D 

 
- Reduce self cast shadow of the object. 
 
[Note] 
*This option will take effect when there’s a spotlight or directional light or both 
  present on the scene. 
 

Shadow Hardness (Default: 0)  

All RealToon Shader All Render Pipeline 
 
- Realtime shadow hardness look. 
 
 

Follow Light (Default: Unchecked) 

All RealToon Shader All Render Pipeline 

 
- Gloss Texture follows light. 
 
[Note] 
*This will adjust the follow light sensitivity. 
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Self Shadow & Realtime Shadow Intensity (Default: 1)  

All RealToon Shader All Render Pipeline 

 
 
- Self Shadow and Realtime Shadow intensity or visibility. 
 
[Note] 
*If Self Shadow feature is disabled, it will only affect RealTime Shadow. 
 
 
 

Enable Screen Space Ambient Occlusion (Default: Unchecked) 

Default Shader URP and HDRP 
 
- This will enable the object to have SSAO/Screen Space Ambient Occlusion. 

Ambient Occlusion Color (Default: Black) 

Default Shader 
 

URP and HDRP 
 

 
- The color of the SSAO/Screen Space Ambient Occlusion. 
 

Enable Screen Space Shadow (Default: Checked) 

Default Shader HDRP 

 

- Enable Screen Space type Outline. 
 
[Note] 
*If this option is enabled, it will also allow you to use DXR/Ray Tracing Shadow. 
*If this option is disabled, it will use the non Screen Space Shadow and shadow 
  map. 
 

 

Self Shadow/Shade Shader Type Render Pipeline 
Self Shadow Intensity (Default: 1)  

Built-In RP/3D 
LWRP 

 
- How visible the Self Shadow/Shade is. 
 

Fade Transparency 
Shader 

 

Threshold (Default: 0.85)  

All RealToon Shader All Render Pipeline 
 
- The amount of Self Shadow/Shade on the object. 
 

Vertex Color Green Affect Self Shadow Threshold (Default: Unchecked)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- Object vertex color blue channel affect Self Shadow Threshold. 
 
[Note] 
*This will not work if the Width option is 0. 
 

Hardness (Default: 1)  

 
All RealToon Shader 

 
All Render Pipeline 

 
 
- Hardness looks of the Self Shadow/Shade. 
 
[Note] 
*Value 1 hard look. 
*Value 0 Soft look. 
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Self Shadow & Real Time Shadow Color (Default: White)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- Self Shadow/Shade and RealTime Shadow color power or intensity. 
 
[Note] 
*Visible if the Overall Shadow Color option is color White or any light color. 
 

Self Shadow & Real Time Shadow Color Power (Default: 1)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- Self Shadow and RealTime Shadow color. 
 
[Note] 
*Visible if the Overall Shadow Color option is color White or any light color. 
 

Light Ignore Y Normal Direction (Default: Unchecked) 

Default Shader URP and HDRP 

 
- Light will ignore object’s Y normal direction if the light angle or position is in X 
or Y 
 

Self Shadow Affected By Light Shadow Strength (Default: Unchecked)  
 
All RealToon Shader 

 

 
All Render Pipeline 

 
- Self Shadow/Shade visibility will be affected by the light shadow Strength. 

 

 

 

 

 

 

 

Smooth Object Normal/Ignore Object Normal Shader Type Render Pipeline 
Smooth Object Normal (Default: 0) 

 
All RealToon Shader 

 
All Render Pipeline 

 
- The amount of smoothed object normal/ignored object normal. 
 

Vertex Color Red Control Smooth Object Normal (Default: Unchecked) 

 
All RealToon Shader 

 
All Render Pipeline 

 
- Object vertex color red channel affect the amount of smoothed object 
   normal/ignored object normal. 
 
[Note] 
*Visible if the Overall Shadow Color option is color White. 
 

Show Normal (Default: Unchecked) 
 

All RealToon Shader 
 

All Render Pipeline 
 
- The amount of smoothed object normal/ignored object normal. 
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Shadow Color Texture Shader Type Render Pipeline 
Shadow Color Texture (Default: Empty)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- Texture to be use to color the shadow. 
 
[Note] 
*Visible if the Overall Shadow Color option is color White or any light color. 
 

Power (Default: 0)  
 
All RealToon Shader 

 
All Render Pipeline 

 
- How strong the Shadow Color Texture is. 
 

ShadowT Shader Type Render Pipeline 
ShadowT Intensity (Default: 1)   

All RealToon Shader 
“Except the Lite” 

 

All Render Pipeline  
- How visible the ShadowT is. 

Shadow T (Default: Empty)  

All RealToon Shader All Render Pipeline 

 
- A Black and White or Grayscale texture to be use as shadow. 
 
[Note] 
*You can use a Flat, Gradient or SDF texture as shadow.  
*Black will always be visible and not affected by the light while Gray and White 
  will always be affect by the light. 
 

Light Threshold (Default: 50)  

All RealToon Shader All Render Pipeline 
 
- The amount of light to affect ShadowT. 
 

Light Threshold (Default: 0)  

All RealToon Shader All Render Pipeline 
 
- The amount of ShadowT. 
 

Hardness (Default: 1)  

All RealToon Shader All Render Pipeline 
 
- Hardness looks of the ShadowT. 
 

Color (Default: White)  

All RealToon Shader All Render Pipeline 

 
- ShadowT Color. 
 
[Note] 
*Visible if the Overall Shadow Color option is color White or any light color. 
 

Color Power (Default: 1)  

All RealToon Shader All Render Pipeline 

 
 
- How strong the color is. 
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Ignore Light (Default: Unchecked)  

All RealToon Shader All Render Pipeline 
 
- Don’t follow the light or Ignore light direction. 
 

Show In Shadow (Default: Unchecked)  

All RealToon Shader 
“Except the Lite” 

All Render Pipeline 

 
- Show ShadowT in the shadow. 
 
[Note] 
*Visible if the Overall Shadow Color option is color White or any light color. 
 

Show In Ambient Light (Default: Unchecked)  

All RealToon Shader 
“Except the Lite” 

All Render Pipeline 

 
- Show ShadowT in Ambient Light. 
 
[Note] 
*Visible if the Ambient Light/Environmental Light or GI is present. 
 

Show In Ambient Light & Shadow Intensity (Default: 1)  

All RealToon Shader 
“Except the Lite” 

All Render Pipeline 

 
- Show In Ambient Light and Show In Shadow visibility. 
 
[Note] 
*Visible if the Ambient Light/Environmental Light or GI is present. 

Show In Ambient Light & Shadow Threshold (Default: 1) 

All RealToon Shader 
“Except the Lite” 

All Render Pipeline 
 
- Show In Ambient Light and Show In Shadow threshold. 
 

Light Falloff Affect ShadowT (Default: Unchecked) 

All RealToon Shader All Render Pipeline 

 
- Light falloff will affect ShadowT. 
 
[Note] 
*Visible if the Ambient Light/Environmental Light or GI is present. 
 

PTexture Shader Type Render Pipeline 
PTexture (Default: Empty)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- A texture to be use as pattern. 
 
[Note] 
*This will only affect Self Shadow/Shade, ShadowT features and RealTime 
Shadow. 
 

Power (Default: 1) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- How strong the PTexture looks. 
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Lighting Shader Type Render Pipeline 
Receive Environmental Lighting and GI (Default: Checked)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- The object will receive environmental lighting and GI. 
 

Environmental Lighting Intensity (Default: 1) 

 
All RealToon Shader 

“Except the Lite” 
All Render Pipeline 

 
- How strong or intense the environmental lighting. 
 
[Note] 
*This is connected to Receive Environmental Lighting and GI option. 
 

Use Old Ambient Light (Default: Unchecked) 

Lite Shaders Built-In RP/3D 
 
-  Use the old unity’s Ambient Light. 
 

Enable Screen Space Global Illumination (Default: Checked) 

Default Shader HDRP 

 
- Enable Screen Space type Global Illumination. 
 
[Note] 
*If this option is enabled, it will also allow you to use DXR/Ray Tracing Global 
  Illumination. 
*If this option is disabled, it will use the non Screen Space Global Illumination. 
 

GI Flat Shade (Default: Unchecked) 
 
All RealToon Shader 

“Except the Lite” 
All Render Pipeline 

 
- Turn GI Shade into flat look. 
 

GI Shade Threshold (Default: 0) 
 
All RealToon Shader 

“Except the Lite” 
All Render Pipeline 

 
- The amount of GI Shade on the object. 
 

Raytraced GI Shade Falloff (Default: 0) 

Default Shader HDRP 

 
- This will adjust the Raytraced Global Illumination shade falloff. 
 
[Note] 
*This will only take effect if the object is in a real time light (Directional, Spot, 
   Point and Area) and the Shadow Color is not color black. 
 

Light Affect Shadow (Default: Unchecked) 

 
All RealToon Shader 

“Except the Lite” 
All Render Pipeline 

 
 
 
 
- Light intensity, color and light falloff affect shadow. 
 
[Note] 
*This will only affect Self Shadow/Shade, ShadowT features and RealTime 
Shadow. 
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Light Intensity (Default: -1) 

 
All RealToon Shader 

“Except the Lite” 
All Render Pipeline 

 
- How strong or intense the light on the shadow. 
 
[Note] 
*This will only affect Self Shadow, ShadowT features and RealTime Shadow. 
*This is connected to Light Affect Shadow option. 
*The default value on RealToon URP and RealToon HDRP is 1. 
 

Use Traditional Light Blend (Default: Unchecked) 

Default Shader URP and HDRP 

 

- This will use the traditional style light blending. 
 

[Note] 
* If enabled light blending will be in add mode. 
* If not enabled the light blending will based on high or maximum light intensity 
   and the blending will be similar to Anime or Cartoon. 
 

Enable Punctual Lights (Default: Checked) 

Default Shader HDRP 

 
- This will enabled the object to receive Punctual Lights (Point Spot and Area 
   Lights). 
 
 

Enable Area Light (Default: Unchecked) 

Default Shader HDRP 

 

- This will enabled the object to receive Area Light. 
 
[Note] 
* If the size of a Rect Type Area Light is too un-even like 'X:24 | Y:1' the light fall 
   off will cause some noise. 
  This only applies when Area Light Smooth Look option is disabled. 
 

Directional Light Intensity (Default: 0) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- How strong or intense the Directional Light on the object. 
 

Point and Spot Light Intensity (Default: 0.45) 

 
All RealToon Shader 

 
All Render Pipeline 

 

- How strong or intense the Point and Spot light on the object. 
 
[Note] 
*On RealToon URP and RealToon HDRP the default value is 0. 
 

Area Light Intensity (Default: 0) 

Default Shader HDRP 
 

- How strong or intense the Area Light on the object. 
 

Tube Light Falloff (Default: 20) 

Default Shader HDRP 

 
 
 
- This will adjust the Tube Type Area Light falloff on the object. 
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Area Light Smooth Look (Default: Unchecked) 

Default Shader HDRP 

 

- This will make the Area Light shades and falloff on the object looks smooth. 
 
[Note] 
*If enabled, Tube Light Falloff option will be disabled. 
 

Light Falloff Softness (Default: 1) 

 
All RealToon Shader 

 
All Render Pipeline 

 
- How soft the Point and Spotlight light falloff is on the object. 
 
[Note] 
*Set this to 0 if you want an anime style light falloff, it is usually hard look. 
 

Limit Light Intensity (Default: Unchecked)   

 
-  This will limit the Light Intensity, Minimum and Maximum light intensity. 
 

All RealToon Shader All Render Pipeline 

Minimum (Default: 0) 

All RealToon Shader All Render Pipeline 
 
-  Minimum light Intensity value. 
 

Maximum (Default: 1) 

All RealToon Shader All Render Pipeline 
 
-  Maximum light Intensity value. 

 

Custom Light Direction Shader Type Render Pipeline 
Intensity (Default: 0)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- The amount of custom light direction sensitivity. 
 

Custom Light Direction (Default: X:0 Y:0 Z:10) 

 
All RealToon Shader 

 
All Render Pipeline 

 

- Custom Light Direction vector value. 
 
[Note] 
*This will only affect Self Shadow/Shade and ShadowT features. 
 

Follow Object Rotation (Default: Unchecked) 

 
All RealToon Shader 

 
All Render Pipeline 

 

- Custom Light Direction will follow object rotation. 
 
[Note] 
*This will only affect Self Shadow/Shade and ShadowT features. 
 

 

Reflection Shader Type Render Pipeline 
Intensity (Default: 0)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- How visible the reflection is 
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Roughness (Default: 0) 
 
All RealToon Shader 

 
All Render Pipeline 

 

- How rough the reflection looks. 
 

Metallic (Default: 0) 

 
All RealToon Shader 

 
All Render Pipeline 

 

- How metallic the object is. 
 
[Note] 
*Change the Main Color to something dark to make it more metallic and dark. 
 

Enable Screen Space Reflection (Default: Checked) 

Default Shader HDRP 

 
- Enable Screen Space type Reflection. 
 
[Note] 
*If this option is enabled, it will also allow you to use DXR/Ray Tracing 
  Reflection. 
*If this option is disabled, it will use the non Screen Space Reflection and use 
  the normal style Reflection. 
 

Mask Reflection (Default: Empty) 

 
All RealToon Shader 

 
All Render Pipeline 

 
- Mask Reflection. 
 
[Note] 
*Use a Black and White or Grayscale texture/map. 
*White is the Reflection part while the Black is the non Reflection part. 
 

 

Rim Light/Fresnel Shader Type Render Pipeline 
Rim Light Intensity (Default: 1) 

Default Shader URP and HDRP 
 
- How visible the Rim Light is. 
 

Unfill (Default: 1.5)  
 
All RealToon Shader 

 
All Render Pipeline 

 
- Reduce Rim Light on the object. 
 

Threshold (Default: 900) 

Default Shader URP and HDRP 
 
- The amount of Rim Light effect on the object. 
 

FReflection Shader Type Render Pipeline 
FReflection (Default: Empty)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- A texture or image to be use as reflection. 
 
[Note] 
*use any 4x4 or equal size texture/image. 
*If you’re using wide size image, Adjust the X Tiling of the FRelfection. 
*FReflection stands for Fake Reflection. 
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Softness (Default: 1) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- How soft the Rim Light is. 
 

Position (Default: X:1 Y:1 Z:1) 

All RealToon Shader All Render Pipeline 
 
- Rim Light position. 
 

Light Affect RimLight Color (Default: Unchecked) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Light intensity, color and falloff affect rim light color. 
 

Intensity (Default: 1) 

Default Shader HDRP 

 
- This will adjust the Light Affect RimLight Color intensity. 
 
[Note] 
*A companion option for Light Affect RimLight Color. 
 

Color (Default: White) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Rim light color 
 

Color Power (Default: 10) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- How strong the rim light color is. 
 

Screen Space Rim Light (Default: Unchecked) 

Default Shader URP and HDRP 
 
- Screen Space type Rim Light 
 

Rim Light In Light (Default: Checked) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Rim light in the light area of the object. 
 

Rim Light In Shadow (Default: Unchecked) 

Default Shader URP and HDRP 
 
- Rim Light in shadow only. 
 

 

Depth Shader Type Render Pipeline 
Depth (Default: 0.2)  

 
Refraction Shader 

 
Built-In RP/3D 

 
- The amount of Depth effect. 
 

Edge Hardness (Default: 0.1) 

Refraction Shader Built-In RP/3D 
 
- How hard the depth edge looks. 
 

Color (Default: RGB: 128) 

Refraction Shader Built-In RP/3D 

 
 

- Depth edge color. 
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Color power (Default: 1.8) 

Refraction Shader Built-In RP/3D 
 

- How strong the color is. 
 

Tessellation Shader Type Render Pipeline 
Smoothness (Default: 0.5)  

All RealToon Shader 
With Tessellation/ 

Default Shader 

Built-In RP/3D 
URP 

 
- Smooth tessellated faces. 
 

Tessellation Transition (Default: 0.8) 

All RealToon Shader 
With Tessellation/ 

Default Shader 

Built-In RP/3D 
URP 

 

- Transition distance between Near and Far. 
 
[Note] 
*0 means mostly near tessellation value while 1 means mostly far tessellation 
value. 
 

Tessellation Near (Default: 1) 
All RealToon Shader 
With Tessellation/ 

Default Shader 

Built-In RP/3D 
URP 

 
- The amount of Tessellation when Near 
 

Tessellation Far (Default: 1) 
All RealToon Shader 
With Tessellation/ 

Default Shader 

Built-In RP/3D 
URP 

 

- The amount of Tessellation when Far. 

Normal Map As Displacement (Default: Unchecked) 

Default Shader URP 

 

- Normal Map as a displacement. 
 
[Note] 
*You need to enable Normal Map feature. 
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See Through Shader Type Render Pipeline 
ID (Default: 0)  

 
All RealToon Shader 

 

Built-In RP/3D 
LWRP 
URP 

 
- ID or Reference value. 
 

Set 1 (Default: None) |  Set 2 (Default: None) 

 
All RealToon Shader 

 

Built-In RP/3D 
LWRP 
URP 

 

[Note] 
*A the see through object. 
* B the object to be seen through A. 
 
*If Set 1 is set to A, Set 2 is also set to A. (See through object) 
*If Set 1 is set to B, Set 2 is also set to B. (Object to be seen through “A”) 
*If the ID of the see through object A is set to 1, the ID of the object to be seen 
through A is also set to 1. 
 
(Important) 
[See through object “A”+ Render Queue set to Geometry (2000).  
*“B” object to be seen through “A”+ Render Queue set to Geometry (2000) and 
minus 1. 
*VRChat users that don’t use this, Set both A and B to “Blank”+ 
(See/open scene “See Through Example” for more info) 
 

Near Fade Dithering Shader Type Render Pipeline 
Min Distance (Default: 0) 

Default Shader URP and HDRP 
- The minimum start fade distance. 

Max Distance (Default: 2) 
Default Shader URP and HDRP 

- The maximum end fade distance. 

Triplanar Shader Type Render Pipeline 
Tile (Default: 1) 

Default Shader URP and HDRP 
- Tiling scale of the texture. 

Blend (Default: 4) 

Default Shader URP and HDRP  
- Blending of the triplanar texture. 
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Perspective Adjustment Shader Type Render Pipeline 
Tile (Default: 1) 

Default Shader All Render Pipeline 
- Tiling scale of the texture. 

Blend (Default: 4) 

Default Shader All Render Pipeline 
 
- Blending of the triplanar texture. 

 
Perspective (Default: 1) 

Default Shader All Render Pipeline 

 
- This will change the perspective of an object to 2D or 3D or FOV stretch look. 

 
[Note] 
*For 2d Anime/Toon look, set it to 0.3 or 0. 
 

Clip (Default: 0) 

Default Shader All Render Pipeline 

 
- This will change the clipping on the object. 
 
[Note] 
* Change this if the object is overlapping front or back. 
 

Close-Up Size (Default: 0) 

Default Shader All Render Pipeline 
 
- This will adjust the size of the object when the camera is closer. 
 

Close-Up Size Smooth Transition (Default: 1) 

Default Shader All Render Pipeline 

 
- How smooth the transition of the sizing. 
 
[Note] 
*Higher value will make the transition smooth, while lower value will make the 
transition strong and fast. 
 

Close-Up Size Smooth Transition (Default: 0) 

Default Shader All Render Pipeline 
- Distance transition from the camera to the object. 
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Disable/Enable Features Shader Type Render Pipeline 
MatCap 

 
All RealToon Shader 

 
All Render Pipeline 

 
- It is a complete material including lighting, specular and reflection that is 
  baked into texture/image. 
 

Normal Map 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Normals that are baked into texture/image. 
 

 
Outline 

 
All RealToon Shader 

 
All Render Pipeline 

Cutout 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Cutting out parts of the object based on the assign texture. 
 

Color Adjustment 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Adjusting the colors of the shader output. 
 

Self Lit 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Self lit, Self illumination or Emission. 
 

Gloss 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Glossy style or looks. 
 

Gloss Texture 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Glossy style or looks in texture/image form. 
 

Self Shadow 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Objects own shadow or shade. 
 

Smooth Object Normal 

 
All RealToon Shader 

 
All Render Pipeline 

 
- Smooth the normals of the object. 
- Useful on Anime/Cartoon model face. 
 
[Note] 
*Add SmoothObjectNormal – Helper Component to your object for this to work. 
 
To Add: 
Click your object then click Add Component then 
RealToon>Tool>SmoothObjectNormal – Helper 
 

Shadow Color Texture 

 
All RealToon Shader 

 
All Render Pipeline 

 
- Shadow colors in texture/image form. 
- It is use for coloring shadow using texture/image. 
 

ShadowT 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Shadows in texture/image form. 
- Add more detailed shadows that can’t produce by the Real time shadow. 
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PTexture 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Patterned texture for comics, pop or manga style shadows.  
 

Custom Light Direction 

 
All RealToon Shader 

 
All Render Pipeline 

 
- Customize light direction for shades. 
- Useful on Anime/Cartoon model face. 
 

 
Reflection 
 

 
All RealToon Shader 

 
All Render Pipeline 

FReflection 

 
All RealToon Shader 

 
All Render Pipeline 

 
- Reflection in texture or image form. 
- A Fake Reflection. 
 

Rim Light 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Light at the edge of the object. 
 

 
Depth 

 

 
Refraction Shader 

 
Built-In RP/3D 

Near Fade Dithering 

Default Shader URP and HDRP 
 
- Object fades when the camera is near. 

Triplanar 

Default Shader URP and HDRP 
 
- For a uniform texture scale and tiles. 
 

Perspective Adjustment 

Default Shader URP and HDRP 

 
- This will adjust the perspective of your object to look 2D Toon/Anime or 
Default 3D. 
 
[Note] 
*Currently, turn off Screen Space Shadow on URP [Forward and Forward+] 
when using this, it will make the shadow distorted. 
 
*On URP [Deferred and Deferred+] no need to turn off Screen Space Shadow. 
 

Smear Effect 

Default Shader URP and HDRP 

 
- Trail lines or Line noise effect when an object moves fast, like the 
Anime/Cartoon.  
 
[Note] 
 *For this to work, you need to add the Smear Effect [Helper]  
Component to your object. 
 
*Adjustable options are on the Smear Effect [Helper] component. 
 
*To Add: Click your object then click Add Component then 
RealToon>Tool>Smear Effect [Helper]. 



 

50 RealToon (MJQ Studio Works © 2016 - 2026) 

 

50 User Guide 

 

Settings Shader Type Render Pipeline 
No Light and Shadow On BackFace (Default: Unchecked)  

 
All RealToon Shader 

 
All Render Pipeline 

 
- No light and shadow on the back side on a face of the object. 
 
[Note] 
* Useful for objects that are plane or quad. 
 

Hide Directional Light Shadow (Default: Unchecked) 
 
All RealToon Shader 

 
All Render Pipeline 

 
- Hide Directional Light cast shadow and received shadow on the object. 
 

Hide Point & Spot Shadow (Default: Unchecked) 

 
All RealToon Shader 

 
All Render Pipeline 

 
- Hide Point and Spot Light cast shadow and received shadow on the 
  object. 
 

Hide Cast Shadow (Default: Unchecked) 
 

Fade Transparency 
 

Built-In RP/3D 
 
- Hide or disable object cast shadow. 
 

Hide Contact Shadow (Default: Checked) 

Default Shader HDRP 
 
- Hide or disable cast and received contact shadow. 
 

Disable Cast Shadow (Default: Checked) 

Default Shader URP and HDRP 
 
- Disable object cast shadow. 

ZWrite (Default: On) 

All RealToon Shader All Render Pipeline 
 
- Turn on Z Depth on object. 
 

ZTest (Default: LessEqual) 

Default Shader URP 

 
- Determines whether a pixel should be rendered based on its distance from 
the camera compared to what is already drawn in the depth buffer (Z-buffer). 
 
[Note] 
*Does not affect outline, there is a dedicated ZTest option for Outline, it is 
under the Outline category. 
 

Render Order (Default: 0) 

Default Shader URP and HDRP 

 
 
 
- This will change the object's Render Order, infront or behind. 
 
[Note] 
*This will affect the Render Queue. 
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Object Position Z CS (Default: 0) 

All RealToon Shader All Render Pipeline 

 
-  Adjust object position z axis in clip space. 
 
[Note] 
*Can also use it to move the object in-front or back. 
*Can also be use for adjusting Perspective Adjustment - Clip. 
 

Disable DOTS Mesh Deformation (Default: Checked) 

Default Shader URP 

 
- Disable DOTS Mesh Deformation: Linear Blend Skinning and Compute 
Deformation.  
 
[Note] 
* Enable this for Static Objects. 
 

Disable Decals (Default: Checked) 

Default Shader HDRP 
 
- Disable received Decals. 
 

Receive Decal (Default: Checked) 

Default Shader URP 
 
- The object will able to receive Decals. 
 

Optimize for [Light Mode:Baked] (Default: Unchecked) 

Default Shader URP 

 
- This will disable all real time features on the shader and optimize it for  
   [Light Mode: Baked] 
 
[Note] 
* Disable or uncheck this for [Light Mode: RealTime or Mixed] use. 
 

Automatic Remove Unused Shader Keywords (Default: Unchecked) 

All RealToon Shader All Render Pipeline 

 
- Remove unused shader keywords automatically in all materials with Realtoon 
  Shader. 
 
[Note] 
* Warning: This will also remove stored previous shaders shader keywords.) 
* This will take effect once this enabled and when the RealToon Inspector 
   shown.  
* You can just enable and disable it right away just to remove the unused 
   shader keyword 
* Disable this if you experience too slow Inspector. 
 

Recursive Rendering (Default: Unchecked) 

Default Shader HDRP 

 
- A replacement pipeline for rendering Meshes in the High Definition Render 
Pipeline (HDRP). 
 
[Note] 
* This option will only work on DXR/Ray Tracing enabled project. 
* Enable transparency to be visible on a reflective surface. 
* Ptexture feature and Pattern Style option will not work on this. 
*If enabled, object will not receive Ray Traced Global Illumination. 
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RealToon Inspector Bottom Toolbar Shader Type Render Pipeline 
Remove Outline (On Shader)  | Add Outline (On Shader) 

 
Default Shader 

 
URP and HDRP 

 
- Remove or Add the outline on the shader. 
 
[Note] 
* This is NOT PER-MATERIAL. 
*THIS WILL MODIFY THE SHADER FILE to remove or add the outline on the 
   shader. 
 

Refresh Settings 

 
Default Shader 

 
URP and HDRP 

 
- This will refresh and re-apply the settings properly. 
 
[Note] 
* Click this if there are some problem, after you update, after material reset or 
   re-import RealToon.  

Video Tutorials 

All RealToon Shader All Render Pipeline 
 
- RealToon video tutorials. 
 

RealToon (User Guide).pdf 

All RealToon Shader All Render Pipeline 
 
- RealToon user guide or documentation. 
 

Hide UI 

All RealToon Shader All Render Pipeline 

 
- Hide RealToon inspector UI. 
 
[Note] 
* This is NOT PER-MATERIAL. 
*This is Global. 
 

 

Settings Shader Type Render Pipeline 
Change Shader Compilation Target to 2.0 or 4.5 

 
Default Shader 

 
URP 

 
 
 
-  This will change the Shader Compilation Target of the RealToon Shader file to 
'2.0' or '4.5'.  
 
[Note] 
*If the Shader Compilation Target is changed to 4.5, the shader will support 
DOTS/DOTS Hybrid Renderer, GPU Resident and Tessellation. 
*GPU Resident available on Unity 6 and beyond. 
* This is NOT PER-MATERIAL. 
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DOTS|HR – Use Compute Deformation or Linear Blend  Skinning 

 
Default Shader 

 
URP 

 
- Will let you change from Compute Deformation or Linear Blend  Skinning. 
 
- For more information about Compute Deformation see : 
  Unity - Compute Deformation  
 
- For more information about Linear Blend Skinning see : 
  Unity - Linear Blend Skinning 
 
[Note] 
*This will only visible if your project is on DOTS and Hybrid Renderer and 
Compilation Target is on 4.5. 
*Use Compute Deformation for blend shape support. 
* This is NOT PER-MATERIAL. 
*If your object is static, it is recommend to enable  
Disable DOTS Mesh Deformation option. 
 

Enable/Disable Tessellation 

 
Default Shader 

 
URP 

 
- This will Enable/Disable Tessellation  feature on the RealToon Shader. 
 
[Note] 
*Change the Compilation Target to 4.5, just click the Change Shader 
Compilation Target to 2.0 button. 
* This will modify the RealToon shader file. 
 

Add|Remove ‘See Through’ feature 

Default Shader URP 

 
- This will add or remove the See Through feature. 
 
[Note] 
*See Through is default remove, if you need it or want to use it just Add it again 
by clicking this setting. 
*Your See Through option settings will not be remove even if you remove or add 
the See Through feature. 
* This is NOT PER-MATERIAL. 
 

Enable/Disable ‘VRC Light Volumes’ feature 

All RealToon Shader Built-In RP/3D 

 
- Enable or Disable VRC Light Volumes support. 
 
[Note] 
*Applicable for VRChat. 
*You need to download and import VRC Light Volumes package before you can 
use this. 
* If you are using the VRC Light Volumes Unity Package version, the folder 
should be in the project folder “/Asset” not in other folder and the folder name 
should be VRC Light Volumes not VRCLightVolumes. 
 

 
 
 
 
 

https://docs.unity3d.com/Packages/com.unity.shadergraph@9.0/manual/Compute-Deformation-Node.html
https://docs.unity3d.com/Packages/com.unity.shadergraph@9.0/manual/Linear-Blend-Skinning-Node.html
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[Important Notes/Tips] 
 

A. You can control the properties of the shaders in your code. 

To see/access the shader properties, just go to RealToon Shaders folder and select the shader 

you want to access. 

 

If you want to learn how to access shader properties by code, just visit this link: 

Unity Doc - API Script - Material 

 

B. URP: if Outline does not appear/show even if you turn Off or On the Outline, do this: 

*Fix  1: Change Depth Priming Mode to Auto. 

*Fix 2: Add Render Object into your Render Feature Asset then change Override Mode to      

            None then change Layer Mask to Default and then add one LightMode Tags then type  

SRPDefaultUnlit. 

 

C. If you are going to use RealToon URP or RealToon HDRP for environment object,  

Just disable the Outline because the custom outline pass on the shader, can’t be batch. 

 

D. To use RealToon URP on a DOTS – Hybrid Renderer project, change the  

Shader Compilation Target to 4.5 under the Settings section. 

RealToon HDRP is already Shader Compilation Target 4.5. 

 

E. To use GPU Resident on RealToon URP, just change the Shader Compilation Target to 4.5 

under the Settings section, On RealToon HDRP, no need to change. 

 GPU Resident available on Unity 6 and Beyond. 

 

F. Disable Outline if your object/s don’t need outline or if you don’t want to use outline and want 

less draw calls or want to use a 3rd party image effects/Post Processing outline. 

 

G. Adjust Reduce Shadow to reduce unwanted object self cast shadow, especially shadow 

artifacts. 

 

H. To properly color shadow, Adjust Lighting -> Environmental Intensity to 0 then change your 

object shadow color, after that, change Environmental Intensity back to 1 or your own value. 

 

I. Note that tessellation only work on DX11/12 to up, OpenGL Core, OpenGL ES 3.1 mobile & 

PS4/XBoxOne and Shader Model 4.6 to up. 

 

J. You can use RealToon together with Unity3D Standard Shader or your other shaders. 

 

K. You can use ShadowT as 2nd self shadow/shade. 

https://docs.unity3d.com/ScriptReference/Material.html
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L. You can use both Directional Light & Point – Spot light at the same time. 

 

M. If you want a manga/comics look, use PTexture and use a half tone texture. 

*Adjust Saturation to 0 if you want that Black and white look and you don’t want to edit the 

texture again. 

N. Always Change the Overall Shadow Color to White if you want to color other shadow features 

like ShadowT & Self Shadow and use PTexture. 

 

O. Enable Light Affect Shadow if you want your shadow to be affected by lights. 

 

P. Fade Transparency & Refraction doesn’t receive shadows. 

 

Q. Use ShadowT for more detailed or additional shadows like the shadows on a cloth or hair. 

 

R. For better Anime/Toon shadow/shading, edit the Vertex Normal of your model by editing it to 

your 3d modeling software or use Smooth Object Normal feature or override object normal by 

using Normal Map. 

 

S. Use Custom Light Direction if you don’t want Self Shadow & ShadowT to not follow the Light 

Direction by script. Useful for anime style faces. 

 

T. Adjust Outline Offset if you want to adjust the outline position. 

* For silhouette outline effect, just adjust Outline Z Position In Camera option. 

 

U. Image Gallery: 

http://mjq3690.deviantart.com/gallery/61884975/RealToon-Shader-Gallery 

 

V. Video Tutorials: 

https://www.youtube.com/playlist?list=PL0M1m9smMVPJ4qEkJnZObqJE5mU9uz6SY 

 

W. Game & Other Uses Demo (Video): 

https://www.youtube.com/playlist?list=PL0M1m9smMVPI1XRV_1UL_Vz3IAHkPtQYT 

 

X. Film/Animation Demo (Video): 

https://www.youtube.com/playlist?list=PL0M1m9smMVPLypGRie4Q7yBgxBtI866Yf 

 

 

 

 

 

http://mjq3690.deviantart.com/gallery/61884975/RealToon-Shader-Gallery
https://www.youtube.com/playlist?list=PL0M1m9smMVPJ4qEkJnZObqJE5mU9uz6SY
https://www.youtube.com/playlist?list=PL0M1m9smMVPI1XRV_1UL_Vz3IAHkPtQYT
https://www.youtube.com/playlist?list=PL0M1m9smMVPLypGRie4Q7yBgxBtI866Yf
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[Contact/Support/Social Network] 
 

Facebook Page: 

https://www.facebook.com/mjqstudioworks/ 

 

Bluesky: 

https://bsky.app/profile/mjqstudioworks.bsky.social 

 

X: 

https://twitter.com/mjqstudioworks 

 

YouTube: 

https://www.youtube.com/channel/UC5sHbeOQdyMPV_Ck0kRgJgQ 

 

MJQ Studio Works Unity Publisher Profile (Support Links & Email): 

http://u3d.as/vDv 

 

Unity 3D Forum: 

https://discussions.unity.com/t/realtoon-an-aaa-toon-anime-shader-and-stylized/632467 

 

Website: 

https://mjqstudioworks.weebly.com/ 

https://www.facebook.com/mjqstudioworks/
https://bsky.app/profile/mjqstudioworks.bsky.social
https://twitter.com/mjqstudioworks
https://www.youtube.com/channel/UC5sHbeOQdyMPV_Ck0kRgJgQ
http://u3d.as/vDv
https://discussions.unity.com/t/realtoon-an-aaa-toon-anime-shader-and-stylized/632467
https://mjqstudioworks.weebly.com/

